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Ron’s Ramblings 
Have you been worried about that email that appears in your inbox each 
month? The one from Postmaster-Owner? Well worry no more. This email 
reminds you of the password allocated to you by the Launceston Computer 
Group Website www.lcg.org.au which allows you to change your personal 
setting in the email lists.  
Which email lists I hear you asking. To explain I am on a number of email 
lists which originate at LCG, committee@lcg, open @lcg,editor@lcg etc. 
These Lists enable a number of people to be emailed without having to 
type in each name every time. 
If you receive this Newsletter by email you are on the list announce-lcg. I 
don’t know all the names on the list and I just send the newsletter to 
“Announce-LCG” and it goes out to members and a few complimentary 
copies to other Computer Groups and Computer Retailers. 
If you wish to see which groups you belong to go to  
http://lcg.org.au/mailman/options/lcg-announce/” 
Eg my lcg-announce listing email gave me the URL 
http://lcg.org.au/mailman/options/lcg-announce/ronbaker%40intas.net.au 
By entering my password as given on the email I can delete my name from 
the list. This email should come out monthly to remind members of their 
pass word. I always list it in a secure place. (Usually my memory, no one 
can find it there, not even me!!!!) 
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Public Officer Judy Hall 6394 7358 publicofficer@lcg.org.
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Web Editor Reinhardt Von 
Samorzewski 

6327 1552 web@lcg.org.au 
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OPEN Session Times 
Studioworks, 1 Pipeworks Rd, L’ton 

Standard Sessions  (All sessions $4.00) 

Special September Sessions 

(Continued on page 4) 

 

Launceston Computer Group 
SOFTWARE LIBRARY 

Dated 1st September 2005 
 

DISK 2000 - Your Library on Disk 
After several months in the production phase  Disk 2000 is now 
available. The change from a floppy disk to a CD has enabled us to 
include much more in the way of games, information and utilities. 
Existing members can upgrade to the new CD version for just $1.50 
. Ask at the club or contact Julie on  6344 5686. This disk is free of 
charge to all new members.  
DISK COPY PRICES - CLUB MEMBERS $1.00 per disk 
Disk Prices - Box of 25 =  $12.00 Members Only 
CD Prices – Box of 10  = $10.00  Members Only 
 

AVAILABILITY OF LIBRARY 
The Shareware Library is available in between 

meetings from the following person. Please 
telephone first to arrange a suitable time.  

The library is also available at the venue - Studioworks 
most Wednesdays 9am to 3pm. Email:  
opencomputingtas@hotmail.com 
LAUNCESTON 
Julie Hjort    Phone 6344 5686 
Flat 2,  115 Penquite Road,  Newstead    
Email:    jhjort@intas.net.au 
 
    

Special Session 
Wednesday September 14 

9am to 12 noon 
 

Searching The Internet 
 

Learn the basic tips and tricks on how to find the 
information you are looking for on the World Wide 
Web. 

-------------------------------------------------- 

Family History Online 
Next Classes 

 
Wednesday September 14th 

1 pm to 3.30 pm 
Standard Family History Session. 

 
Wednesday September 28th   

9 am to 12 noon 
$4.00 fee     Numbers limited to 8 people 

Please register on noticeboard for both sessions. 
----------------------------------------------- 

 
Wednesday September 21st 

9 am – 12 noon 
“Easy Photo Repairs 2” 

Getting started with Paint Shop Pro, how to get 
your photos onto the computer and basic 
manipulation. 
Please bring your own photos. 
 

Numbers limited to 8 people 
Please register on noticeboard 

 
-------------------------------------------- 

 
Paint Shop Pro 7 

Advanced Class 
Wednesday  September 21st 

 
1pm – 3.30 pm 

 
$4.00 fee - Numbers limited to 8. Please register on 

noticeboard or call OPEN.  
 

-------------------------------------------------- 

Monday 10 am -12 E-Learn & Beginners 

Monday 1pm – 3pm Basics & Beyond 

Tuesday  10am – 12 PC & Mac  Support for 
Beginners 

Tuesday 1pm – 3pm E-Learn  
 & Beginners 

Wednesday 9am –12 Special sessions or Meet-
ings) 

Wednesday 1 pm – 3.30 
pm 

As for mornings  
(see rosters) 

Thursday 10 am – 12 Beginners or E-Learn 
(Mac p.m.) 

Thursday 1pm - 3pm  

Friday 10am -12 E-Learn & Begin’rs 

Friday 1pm – 3pm Embroidery Class 

2nd Sat 9 am - 12 NT Camera Club 

Wednesday 7th 
September 

9 am- 12 
noon 

“What’s in the Box?” 

Wednesday 7th 
September 

1 pm 
onwards  

OPEN Monthly Meeting 

Wednesday 14th 
September 

9 am –12 
noon 

Searching the Internet 

Wednesday 14th 
September 

1 pm – 3.30 
pm 

Family HistoryOnline 

Wednesday 21st 
September 

9 am –12 
pm 

Easy Photo Repairs 
with PSP7 

Wednesday 21st 
September 

1 pm – 3.30 
pm 

Graphics PSP7 
Tutorial 

Wednesday 28th 
September 

9 am –12 
pm 

Family History Online 

Wednesday28th 
September 

1 pm – 
3.30 pm 

Scanning and Saving 
to CD-ROM 
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(Continued from page 3) 

What’s Happening at OPEN 
Next Monthly Meeting 

September 7th  at 1 p.m. 
-------------------------------------------------- 
FROM THE ASSISTANT EDITOR 
 
A Few Changes! 
The last couple of months have seen a few 
changes in personnel and equipment at OPEN.  
 
New  tutors include Peter Brickwood who been 
associated with the IT industry for ‘decades’, Lindy 
Kittel, and Linton Targett who will be with us for a 
few months as part of his studies at the University 
of Tasmania. 
 
On the equipment side most noticeable are the two 
21-inch monitors connected to OPEN7 and 
OPEN12. These were kindly donated by the Online 
Access Centre. Thank you Craig! 
 
The ‘box’ on OPEN12 is also new. I won’t bore you 
with technical details – let’s just say it is much 
more capable machine than its predecessor. It 
uses the Windows 2000 operating system and is 
the first of our computers to be equipped with 
Office 2003, with the latest versions of Word, 
Excel, PowerPoint etc. 
 
As finances permit, we will continue to provide 
upgraded facilities to help you enjoy your learning 
experiences. 
                                                            
                                                Dennis Murray  
------------------------------------------------------- 

 
 

NORTHERN TASMANIAN 
CAMERA CLUB 

 
The next meeting of  the Camera Club will be held at 
the OPEN clubrooms on Saturday, September 17. 
  
If you are interested in learning more about digital 
cameras and related subjects contact Kai Johnson on 
6326 2358. 

-------------------------------------------------------- 
 

“VICTOR” 
 

Members are again reminded that the Volunteer ICT 
Outreach program is available to assist members who 
may be having computer problems that can’t be solved 
in the classroom.  
 
For a donation of $5 per hour one of our tutors will 
come to your home to help you with problems, such as 
virus detection and removal, or installing a new 
program. 

 
-------------------------------------------------------- 

 
 “EMBROIDERY GROUP” 

 
The Friday afternoon Embroidery Group is having a rest 
for a few weeks and will resume around the end of 
September. 
 
If you are interested in learning how computer 
programs interact with an electronic sewing machine, 
please contact Eleanor Horder via the club. 
 
-------------------------------------------------------- 
 

(Continued on page 5) 

 

L.C.G. Meeting 
Wednesday September 7th  

7 pm – 9.30 pm 
A general information session for those members 
who may find it difficult to attend day-time sessions. 
----------------------------------------------------- 

OPEN’s Monthly Meetings 
 
We remind members that the meetings held on the 
first Wednesday of each month are for ALL 
MEMBERS to attend to contribute their ideas and 
suggestions on how the club should operate. 
 
Next Meeting September 7th, 2005 –   

At 1 pm. 
 

-------------------------------------------------- 

Email Listing 
If you have provided your E-Mail address to OPEN or 
LCG we can use that information to send you the 
LCG/OPEN newsletter. If you do not want your E-
mail address listed  please advise the club and we 
will remove it from our records. 
-------------------------------------------------- 

 

VENUE TELEPHONE NUMBER 
 
Mobile Phone Number is now available to all those 
wishing to contact OPEN during the club’s hours of 
operation.  The number is 

0413 698 610 
 

---------------------------------------------- 
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“MEET THE TUTOR” 
Liz McCashin 

 
Liz’s interest in computing began about four years ago with a basic course at 
Adult Education.  
 
Liz found out about OPEN through Volunteering Tasmania and has been a 
volunteer tutor for nearly twelve months and also assists with the VICTOR 
outreach program. 
 
“I thoroughly enjoy helping people learn because I was once ‘in their shoes’ ” says 
Liz. “Everyone is so helpful, and for me there is still so much to learn.” Liz believes 
in the saying that “You’re never too old to learn something new.”  
 
Liz has developed a variety of special interests in her four years of computing, 
including compiling CDs from vinyl records, digital photography, using photo-
editing software to make collages, and making greeting cards. 
 
Her most recent exploit involves creating DVDs from home movies taken on a 
recently-acquired handy-cam.  
 
Wow!! What do you do in your ‘spare time’, Liz?? 
 

------------------------------------------- 
JANET’S TIPS AND TRICKS 

 
A continuing series of handy hints and tips from OPEN chairperson 

Janet Headlam 
 

1. Members using the Internet are advised NOT to download a screen-saver 
called “FROGS”. There is no known remedy for this computer nasty, and 
activating it could result in a COMPLETE COMPUTER CRASH!!! 

2. Always ensure that you have the latest updates to your anti-virus and ad-
blocking programs BEFORE browsing the Internet or opening E-mails. 

3. When labelling any CDS that you have burned USE one of the special CD 
pens that have been developed for the purpose. Using biros or other 
marking pens may damage your CDs. 

 

And one from Dennis : 
 
Don’t underestimate the value of HELP, whether it is the HELP that you find in 
programs such as Word and Excel, or the overall Windows HELP files that can be 
accessed from the START menu. 
Not only are you likely to find the answer to a specific question – you might also 
discover some new information. 
 

TUTORS’ MEETING 
 

There will be a special Tutors’ meeting at 1 pm on Wednesday, September 5, to 
discuss any matters that have arisen during classes. 
 
For this Monday afternoon only tutors will not be available to assist in the ‘Second 
Step’ class, but members are welcome to come along and ‘do their own thing.’ 

Time For A Laff 
A helicopter was flying around above Seattle yesterday when an electrical 
malfunction disabled all of the aircraft's electronic navigation and 
communications equipment. Due to the clouds and haze, the pilot could not 
determine the helicopter's position and course to steer to the airport. 
The pilot saw a tall building, flew toward it, circled, drew a handwritten 
sign, and held it in the helicopter's window. The pilot's sign said "WHERE 
AM I?" in large letters. 
People in the tall building quickly responded to the aircraft, drew a large 
sign, and held it in a building window. Their sign said "YOU ARE IN A 
HELICOPTER." 
The pilot smiled, waved, looked at his map, determined the course to steer 
to SEATAC airport, and landed safely. 
After they were on the ground, the co-pilot asked the pilot how the "YOU 
ARE IN A HELICOPTER" sign helped determine their position. 
The pilot responded "I knew that had to be the MICROSOFT building 
because, similar to their help-lines, they gave me a technically correct but 
completely useless answer."  
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format - Tiff or MDI (Microsoft Office Document Imaging) and the level 
of compression to use. 
The Page tab lets you set a page size and the ability to save each page as a 
separate file or not. 
The Output tab lets you configure a storage location for the scans and a 
naming convention - such as a number, date and time or a name based on 
the first words on the page. 
The Processing tab lets you configure what processing is applied to the 
scan such as rotation, straightening and OCR to convert the scan into 
editable text. When you're done the Preset will be added to the list. 
Clicking the Scanner button and selecting your scanner lets you choose 
whether the scanner's own dialog shows before the scan is performed - in 
most cases this won't be necessary and you can speed up the process of 
scanning by leaving this option unselected. 
When you're ready to scan, check the Prompt for additional pages 
checkbox and click Scan. When the first page is scanned, you'll be 
prompted to scan another page and you can do this repeatedly until the 
entire document is scanned. If the View file after scanning option was 
enabled when you started the scan, the Microsoft Office Document 
Imaging application will open automatically when the scan is complete to 
display the scanned file. 
OTHER SOFTWARE OPTIONS This Office option is useful in some 
circumstances but it is necessarily limited to basic features. Usually a 
better option is to use the software that comes with the scanner. 
That software can make use of all the features in the scanner and often will 
provide features beyond the Microsoft scope. Most commonly, you can 
save documents to a PDF format directly or to JPG format (good for 
pictures). 
If you want to drop a scanned image into a document, your scanner 
software might have a 'scan to clipboard' option. With this you end up with 
the scanned image in your Windows clipboard ready to paste into the 
location you want with no intermediate file. 

(Continued on page 7) 

WORKING WITH OFFICE DOCUMENT IMAGING, 
PART 1  
If you only ever use the Quick Launch icons to launch Office applications 
you will be missing out on three handy Office tools: Microsoft Office 
Document Imaging, Office Document Imaging Writer and Microsoft 
Office Document Scanning. These tools are linked to each other and they 
provide a handy interface for scanning, viewing and annotating scanned 
documents and for converting scanned text into editable text using OCR. 
MICROSOFT OFFICE DOCUMENT SCANNING  
By Helen Bradley and Peter Deegan  
The Microsoft Office Document Scanning tool is a small dedicated 
interface for scanning documents. While this might not seem like a 'big 
thing' it is a small but effective scanning application that lets you do things 
like scan images into multi-page Tif or MDI files. 
So, for example, when you need to scan and retain a large document like a 
contract, you can scan it into one file rather than have one file for each 
page in the document. 
The Microsoft Office Document Scanning tool also lets you configure 
scanner presets which are configurations for various scanning jobs. If you 
regularly scan documents using Grayscale mode and a set resolution, you 
can configure this as a preset in the Microsoft Office Document Scanning 
application and then use it by selecting the preset name when you need it. 
This saves you having to set the scanner options manually each time. 
So, enough about what it does, how do you find it? To launch Microsoft 
Office Document Scanning choose Start, All Programs, Microsoft Office, 
Microsoft Office Tools, Microsoft Office Document Scanning. On the 
screen is a small dialog - select a preset from the list and click the Scan 
button to start the scan. 
MAKE YOUR OWN PRESET To create your own preset, click Preset 
Options, Create New Preset, give it a name and click OK. 
Now configure the settings for the scan preset - you can choose the type of 
scan from a list or configure it to your own specifications by clicking the 
Advanced button and select the options such as Resolution, type, save file 
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(Continued from page 6) 

While the Microsoft Office Document Scanning tool can do OCR (convert 
a document into text) normally the software that came with the scanner 
will do a better job. 
The Office Document Scanning tool is a handy to know about for 
'emergencies'. Perhaps the makers scanner software is broken or you've 
plugged a scanner into a new machine without the full software. 
MULTI-PAGE FILE FORMATS An often overlooked point is the 
importance of multi-page image formats. 
Many common image formats like JPG and GIF can only show a single 
image - which is no good if you have a document that is more than a single 
page. You could save each page as a separate image but there are better 
options. 
TIF / TIFF format can support multiple page images in a single file. But 
not all programs will support multi-page TIF's. For example the Windows 
Paint program by Microsoft will open and display the first page of a multi-
page TIF but there's no way to move to the other pages. That fact plus the 
relatively large file size means it is best to avoid TIF format for 
documents. 
MDI is a Microsoft only standard which might be fine for internal 
company use. Since you don't know what other people might have on their 
computers, trying to share a document in MDI format might be more 
trouble than it's worth. In addition MDI documents are often larger than 
their Word document original - which somewhat defeats one of the major 
benefits. 
PDF from Adobe is still the gold standard for sharing a document. The 
viewer is free and available for many operating systems. It can support 
multiple pages and a PDF is often much smaller than the original 
document. 
While you probably have plenty of disk space, the size of the scanned 
image is important if you want to email the file. That's another reason why 
TIF and MDI are not as useful as PDF.  

OFFICE DOCUMENT IMAGING WRITER  
By Helen Bradley and Peter Deegan This is a 'printer' that actually saves 
the document as it would be printed to a file instead. You'd get the same 
result if you printed the document to paper then scanned in the pages. This 
is faster and gives a cleaner result. 
In Office 2003 you'll see the 'Microsoft Office Document Image Writer' 
among the list of Windows printers. 
Select it as your printer in the Print dialog box then choose 'Properties'. 
This will let you select the 'paper' size plus the format to save the 
document image as (MDI or TIFF) plus the default folder for saving the 
image. 
When you click 'Print' in the Print dialog you'll get a familiar File Save 
dialog to choose where to save the file. The option at the bottom of the 
dialog lets you choose to open the document image in a viewer after 
saving. 
Despite the name and being part of Office, the Document Imaging Writer 
should work with any Windows program. In theory, you could make 
document images from the Print option in any Windows program. But 
don't count on it, we've had some reports of programs that can't work with 
this utility. 
Tip: The Imaging Writer tool is a bit more accurate than Print Preview for 
really precise work. Rather than waste paper you can use the Imaging 
Writer to see how the final pages will look.  
OFFICE DOCUMENT IMAGING TOOL Last time we looked at the 
Microsoft Office Document Scanning tool that comes with Office 2003. 
This time we'll look at the Microsoft Office Document Imaging tool which 
is found by choosing Start, All Programs, Microsoft Office, Microsoft 
Office Tools, Microsoft Office Document Imaging. 
This tool has been around in various guises for many years but it's never 
got a lot of press so most users don't even know it exists. It is the tool that 
lets you view and manipulate files you've created with the scanning and 
image writer tools. 
Microsoft Office Document Imaging is handy for a few things - one of 
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the Scan New Document button on the toolbar. Click it to open Microsoft 
Office Document Scanning ready for scanning a new document. 
ANNOTATING DOCUMENTS Perhaps the most impressive part of 
Microsoft Office Document Imaging is the ability to annotate documents. 
Use the tools on the Annotations toolbar (View, Toolbars, Annotations) to 
add annotations to your documents. You can highlight text, add text in a 
text box, draw objects using the pen and even add clip art images or 
images from the Windows clipboard. All this happens on a separate layer 
to the original scan and you can disable the visibility of this layer if you 
want to or print the document with the annotations in place. To view or 
hide Annotations choose Tools, Annotations, Hide Annotations (or Show 
Annotations). POWER FAXING One handy use I regularly have for the 
Microsoft Office Document Imaging tool is for assembling large 
documents for faxing. By printing from Word and Excel etc., to the MDI 
format I can open the resulting files and drag and drop pages from one or 
more Word documents and sheets from Excel printouts or any other 
program into a single file ready for faxing with the Windows Fax tool. 
You can rearrange the pages from multiple sources just like you could 
with paper pages. 
You can use the Annotation feature to highlight items in the pages before 
faxing, without messing with the original Office documents. 
Storing the entire fax in a single file makes for tidy storage and more 
accurate record keeping of what was actually sent. 
Using the Imaging Writer plus the in-built faxing feature in Windows 
might save you spending money on separate fax software. 
Tip: Windows Fax can have trouble with faxing large documents when 
you print to it direct from Word or Excel, however, printing to an MDI file 
as an interim step before faxing gets around this. 
Of course, the Adobe PDF format is a better choice for documents for 
display on the web and for sharing with others than Tif or MDI. However, 
for some tasks, you may find that Microsoft Office Document Imaging and 
Microsoft Office Document Scanning are the tools you've had on your 
Office wish list without realizing you already have them.  
From OfficeWatch 10.28 & 10.29 

(Continued from page 7) 

them is for viewing documents saved in the TIF or MDI (Microsoft 
Document Imaging) formats which are the two formats you can save scans 
in using the Microsoft Office Document Scanning tool. The MDI format is 
also a format you can use to print to from various Office applications - you 
do this by choosing the Microsoft Office Document Image Writer as your 
printer. Both the Tif and MDI formats can contain multiple pages in one 
file. 
When you open a document in Microsoft Office Document Imaging you 
can arrange the screen so you see thumbnails of your pages down the left 
of the screen and one page at a time on the right. To do this, choose View 
and make sure both Thumbnail Pane and Page Pane are checked. 
Arrange the pages in a different order in the file by dragging and dropping 
their thumbnails in the thumbnail pane. If you have two files open in two 
separate Microsoft Office Document Imaging windows you can drag 
thumbnails from one document to copy pages from one to the other - hold 
Shift as you drag to move the page. 
Use the File, Insert File command to insert one entire file inside another 
and use Tools, Save Pages As to write some pages from a file to a new and 
separate file.  
CONVERT DOCUMENT IMAGE TO TEXT A small eye icon in the 
bottom right corner of a thumbnail indicates that the page contains 
recognized text - if it doesn't you can run recognition by clicking the 
Recognize Text Using OCR icon on the toolbar. Because Optical 
Character Recognition (OCR) ability is built into Microsoft Office 
Document Imaging you can find text in your scanned document by 
clicking the Find button, type the word to find and click Next to locate it. 
When OCR has been run, choose the Send Text to Word button to send the 
recognized text to a new Word document. You can send all pages or just 
those you have selected prior to clicking the button. The Reading View 
maximizes the window to take up all the screen so you can read the 
document more easily. Press Escape to return to the original window. 
This program also has a link to Microsoft Office Document Scanning via 
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PROFOUND THOUGHTS 
 "Some marriages are made in heaven, but so are thunder and 
lightning." 
"Marriage is a lot like the army, everyone complains, but you'd be 
surprised at the number that re-enlist." - James Garner 
"Keep your eyes wide open before marriage, half shut afterwards." - 
Benjamin Franklin 
"Don't assume that every sad-eyed woman has loved and lost - she 
may have got him." 
"A man usually falls in love with a woman who asks the kinds of 
questions he can answer." - Ronald Colman 
"Before marriage a woman's favourite three little words are 'I love 
you', after marriage they are, 'let's eat out'." 
"By all means marry: If you get a good wife, you'll become happy; if 
you get a bad one, you'll become a philosopher." - Socrates 
"A diplomatic husband said to his wife, 'How do you expect me to 
remember your birthday when you never look any older?' "  
"It takes a smart spouse to have the last word and not use it." 
"The honeymoon is over when he phones to say he'll be late for 
supper and she's already left a note that it's in the refrigerator." - Bill 
Lawrence 
"The average woman would rather have beauty than brains 
because she knows that the average man can see much better than 
he can think."  
 "A good marriage would be between a blind wife and a deaf 
husband." - Michel de Montaingne 
"Alimony is like buying oats for a dead horse." - Arthur Baer 
"Marriage is a great institution - but I'm not ready for an institution 

yet." - Mae West 
"When a man steals your wife, there is no better revenge than to let 
him keep her." - Sacha Guitry 
"You have only to mumble a few words in church to get married and 
a few words in your sleep to get divorced." 
"If there is any realistic deterrent to marriage, it's the fact that you 
can't afford divorce." - Jack Nicholson 
"The person who marries for money usually earns every penny of 
it." 
"The most difficult years of marriage are those following the 
wedding." 
"A woman has got to love a bad man once or twice in her life to be 
thankful for a good one." - Marjorie Kinnan Rawlings 
"Marriage is like twirling a baton, handsprings, or eating with 
chopsticks. It looks easy till you try it." 
"If men acted after marriage as they do during courtship, there 
would be fewer divorces - and more bankruptcies." - Frances 
Rodman 
"Some husbands are living proof that a woman can take a joke." 
"Many husbands go broke on the money their wives save on sales." 
"There are two times when a man doesn't understand a woman - 
before marriage and after marriage." 
"In Hollywood all marriages are happy. It's trying to live together 
afterwards that causes the problems." - Shelley Winters 
"No woman ever falls in love with a man unless she has a higher 
opinion of him than he deserves." - Edgar Watson Howe 
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The top radio button will allow you to configure each of your hard drives 
separately. The second radio button creates one rule for all your drives. 
You will notice an option to delete files without storing them in the 
Recycle Bin. There is a security feature that will ask you to confirm the 
deletion. The slider control allows you to set the amount of space you want 
reserved for the Recycle bin. By moving the slider control you can either 
reduce or increase the size of the Recycle Bin. There is also a check box 
that you can check or uncheck to prevent or activate the delete 
confirmation message from appearing at deletion time. 
By using these different controls, you can set your Recycle Bin according 
to your needs and according to the size of your hard drive. If you work on 
smaller documents you might want to reduce the size of the Recycle Bin. 
If, on the other hand, you work on database, video or graphic files, it might 
be a good idea to increase the size of your Recycle Bin to accommodate an 
accidental deletion. 
You need to weight your need for hard drive space and the safeguarding of 
accidental deletion of files. Remember, if your Recycle Bin is full, 
Windows will delete older deleted files to make room for newly deleted 
files in the Recycle Bin. 
To get more information about the Recycle Bin, go to Online Help. Click 
the Start button, click Help, click Search and type in Recycle Bin. You 
will then be able to read about shortcuts, how to retrieve deleted files, and 
much more. Article by Joe Robson, author of the Newbie Club Best Seller 
'Windows for Newbies' at http://newbieclub.com/wfncopy 
 From Newbie Club Insider 9/8/2005 

Article... "How To Manage Your Recycle Bin" By Joe 
Robson http://newbieclub.com 
The properties of the Recycle Bin might not concern you as much if you 
have a very large hard drive. Hard drives with very large storage capacity 
are becoming more affordable. However, many people still use relatively 
small hard drives with limited storage space and this information could be 
very beneficial for them. 
I would even venture to say that it truly does not matter how much space 
you have on your hard drive, the Recycle Bin will enter your life at one 
time or another. 
Files are deleted on purpose or by accident. The amount of space you 
allow for your Recycle Bin can make the difference between being able to 
retrieve those files or not. If you have allowed adequate space for the 
Recycle Bin you can retrieve a file that was accidentally deleted. 
To retrieve a deleted file ... 
Open the Recycle Bin, 
Locate the file you've just deleted, 
Click on it to highlight it, 
Open the File Menu in top tool bar, 
Click Restore. 
Deleted documents or files will remain in the Recycle Bin until you clean 
out the Recycle Bin or until Windows claims that space for newly deleted 
files. 
Windows automatically sets aside 10% of your hard drive as storage space 
for the files or folders that are deleted and sent to the Recycle Bin. This 
means that if you have a 1000 MB hard drive, then 100 MB will be used 
by the Recycle Bin. 
If your hard drive is low on space and you do not create very large 
documents, you might want to reduce the size of the Recycle Bin and 
increase the available space on your hard drive. 
To set the properties of the Recycle Bin, right click the Recycle Bin icon 
on your desktop and click on Properties.The Recycle Bin dialogue box 
will open up. 
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ADDRESS SEARCH. Hidden in your Windows 
98 is a feature you may be unaware of. Click 
Start|Find|People, and a window opens to allow a 
search from your existing address book or 7 
major search engines. Click on a name resulting 
from the search and more details are opened. 
Click on "Add to address book" and it does just 
that 

The Taskbar (at the bottom of your screen) contains the following items: 
The Start menu button 
Minimized applications (programs) 
Quick launch toolbar 
System tray 
The taskbar can be resized to contain as much or as little as you want, or 
hidden from view entirely. But it obviously takes up space - and space is at 
a premium on your monitor screen. 
To hide it ... 
Right click a blank area of the taskbar 
Select Properties. 
Tick the Auto hide check box 
Click Apply. Then click OK to put the dialog box away. 
The bar will slip down into the nether regions of your monitor, and will be 
available for viewing when you run your mouse cursor to the bottom of 
your screen. 
To revert back to 'normal' just uncheck the box you checked to make it 
stay put.  

From Newbie Club Insider 9/8/2005 

Geek-Speak Busters 
1. ......... POP stands for Post Office Protocol. 
It's simply a set of rules that are followed on the Internet with respect to 
the arrival of your email in an inbox. You receive mail into a POP account 
if you use Outlook Express, Eudora, Pegasus, or some other email client to 
check your mail. 
2. ......... "Splash Screen" 
This is a term given to any window that appears prior to the actual pro-
gram you're waiting to use. 
For example ... 
The Windows screen you see when turning on your computer that says 
"You are not starting Windows..." (duh!) is a splash screen. It's splashed 
momentarily on your screen. 
3. ........ "Path" 
The ankle bone connects to the shin bone. The shin bone connects to the 
knee bone. The knee bone connects to the... you know. Well, a 'path' on 
your computer is a series of folders along the way. The path you follow to 
get to a specific resource. Kind of like the various parts of your anatomy 
connecting to other various parts... 
Okay, here's an example: 
C:\My Documents\Recipes\cornbread.txt 
'cornbread.txt' is the file name. It's found in the 'Recipes' folder, which is 
found in the 'My Documents' folder, which is found in the C: folder... 
which is your hard drive. So the 'path' to cornbread.txt goes through the C:
\My Documents\Recipes forest. 
Why does this matter? 
It's just lingo. But without knowing the lingo, your trip through the Black 
Forest of computers will be filled with terror and frustration. Right? Of 
course. :-) And of course knowing where the cornbread recipe is located is 
a good thing. I'm just not sure you'd find one in a forest. Unless it was a 
forest of... corn.  
Tutorial ... "How To Hide Your Taskbar" 
The Taskbar is a critical component of Windows, so lets turn it inside out. 

Time For A Laff 
 
An astronaut in space was asked by a reporter, "How do you feel?" 
 
"How would you feel," the astronaut replied, "if you were stuck here, on 
top of 20,000 parts each one supplied by the lowest bidder?" 
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A Zero-Footprint, "Live CD" Version Of XP 
If you ever have to recover files from an unbootable drive or try to bring a 
dead PC back to life, here's a free, zero-footprint tool you shouldn't be 
without. 
It's a self-contained, CD-based "live" copy of Windows XP. Like the 
popular "live CD" versions of Linux that can run entirely from a CD-ROM 
without installing anything on to or making any changes to a system's hard 
drive, this version of XP lets you boot and run just about any PC without 
altering anything on the system itself. 
The CD-based version is completely self-contained--- you can think of it 
as a zero-footprint installation of XP--- and yet is "...a complete Win32 
environment with network support, a graphical user interface (800x600) 
and FAT/NTFS/CDFS file system support. Very handy for burn-in testing 
systems with no OS, rescuing files to a network share, virus scan and so 
on." 
And it's free! 
I've been experimenting with it for a while now, and enthusiastically 
recommend it. So much so, in fact, I devoted a new InformationWeek 
column to it. It starts with screen shots, showing you what it does and 
exactly how it looks in operation (on one of my PCs here), and then goes 
on to provide links and info so you can download the free tools to build 
your own copy. 
This is one of the best, if not *the* best, foundation for a CD-based repair/
recovery toolkit I've seen to date. With native NTFS support, plus support 
for networking, file sharing, and Remote Desktop Connections, it's 
powerful and flexible, and yet the XP-derived interface makes it familiar 
and easy to use. 
Click for full info on this must-have repair/recovery tool! http://www.
informationweek.com/story/showArticle.jhtml?articleID=167100904 The 
article, like the tool itself, is free! Copying/Storing Gigantic Files 
Fred, I have MANY software programs I have downloaded from the web... 
I'd like to put these on CD's.. (currently filling up a harddrive).. 
most all the programs are larger than what the CD will hold.. How can I 

reduce them to place on one CD. Do not want to image them, then have to 
go through the processes of converting the image, to install program. 
sure hope you can understand what I mean. Thanks, Jack 
Some tools and tool suites are indeed quite large, but there are several 
options for getting them onto a storage medium--- any medium--- where 
they normally wouldn't fit. 
One simple approach is to use a tool like Winzip ( http://www.winzip.
com/ ), which can compress the original files and also split the resulting ZIP 
file into chunks of whatever size you specify. You can then copy the 
individual pieces to your storage medium--- say, one piece per CD, or 
whatever. Later, if you need to access the stored file, Winzip can stitch the 
separate pieces back into a coherent whole, and then decompress the 
reconstituted file, getting you the files back in their original size and format. 
Of course, you can use any other file compressor (including some free ones: 
http://www.google.com/search?q=free+zip+compress ). Some of those also 
allow file splitting, built-in. 
There also are many free file splitter tools available, which can work on 
either the original or compressed files: You use the tool to split the file into 
pieces sized appropriately for your storage medium, and then (later) use the 
same tool to reassemble the separate chunks into a working whole again. 
File splitters: http://www.google.com/search?
hl=en&lr=&q=file+splitter+free 
A unified tool like Winzip makes handling large files easier because 
everything you need is all in one place. But you can certainly accomplish 
the same results with free tools, perhaps with just a little less convenience. 
But either way, compressing and/or splitting the original files into chunks 
that fit your storage medium gives you the ability to handle and store just 
about any file on any medium--- even floppies 
From LangaList 11/8/2005 
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SPECIAL REPORT: Protect your media player from 
podcasts 
By Brian Livingston 
It should be fun and harmless to play podcasts — short radio and television 
programs that download automatically from the Internet. But dumb 
programming mistakes in popular media players can allow spyware to 
silently infect your PC while an apparently innocent multimedia file is 
playing. 
In the first part of my special report on podcasts, published last issue, I explained 
that applications designed for media downloading — called "podcatchers" — can 
cheerfully save hacked media files or even troublesome executable files to your 
hard disk. 
In the second part of my report, I'll explain today the steps you can take to protect 
yourself. 
Infected executable files, in this case, aren't actually your most serious problem. 
Let's say a podcast you download happens to really be, for example, a dot-exe 
file. If your podcatching software downloaded the file earlier and you absent-
mindedly try to play it, your media player will probably do nothing. It'll just sit 
there, waiting for you to load a file type it understands. 
The real danger occurs if your media player allows a "poisoned" audio or video 
file to silently run commands or install other files. 
You'd think media players would support nothing but audio, video, and still 
images. But, amazingly, these players have a history of letting multimedia files 
get away with murder. 
The good news is that playing podcasts on a specialized MP3 player — such as 
an Apple iPod or a Creative Zen Micro — probably won't infect these little 
devices. They run simple operating systems and aren't full computers, so they're 
not attractive targets. 
The bad news is that, if you watch video podcasts or listen to audio podcasts 
using Windows or a Pocket PC, any weaknesses in your Microsoft or third-party 
media player can expose you to infection. 
If you have a broadband connection, in particular, your PC is a valuable resource 
for hackers who'd love to install their spyware. They can then show you pay-per-
click pop-up ads, use your bandwidth to quietly send millions of pieces of spam, 
or launch denial-of-service attacks against Web sites. 
The solution is to keep your media player updated with the latest vendor patches. 
This can be a simple and trouble-free task. Once your player is updated, you can 
relax and enjoy podcasts safely. 
In the following sections, I'll tell you how to fix whichever media player you may 
use — Windows Media Player, iTunes, QuickTime, RealPlayer, or Winamp 

 Update Windows Media Player to avoid surprises 
Late in 2004, computer experts noticed that a popular Windows Media Player 
video file was actually a silent delivery mechanism infecting millions of PC users 
with spyware. 
On Jan. 3, 2005, security researcher Ben Edelman revealed what was happening 
to people who played this video file in WMP. After clicking the OK button on a 
single, legitimate-looking "browser update" dialog box, "My computer quickly 
became contaminated with the most spyware programs I had ever received in a 
single sitting," he said. 
Edelman counted an amazing total of 31 programs that had silently been 
installed, without even displaying a license agreement. These included adware 
from 180solutions, CoolWebSearch, Ezula, ISTbar, and many other adware 
companies, he said. (By the way, I reported on July 14 that Microsoft's 
AntiSpyware beta program, to the dismay of spyware experts, has stopped 
recommending the removal of programs by 180solutions, Ezula, and some other 
adware companies.) 
How the trick works: Media files that are played using recent versions of 
Windows Media Player, such as 9.0 and 10.0, can invoke Microsoft's Digital 
Rights Management system. This DRM scheme allows multimedia files, among 
other things, to open a Web page and display information to the user. 
Allowing audio and video files to open new windows is not such a good idea in 
the first place. Even worse, however, is how DRM was implemented by Microsoft. 
DRM-protected multimedia files, when played in WMP, can make a dialog box 
appear, such as the one shown above that Edelman diagnosed. (This image is 
reproduced with Edelman's permission.) In this case, the dialog box tells the user 
to click the Install button to get what was supposedly a Required Media Player 
Version 10 Browser Update. 
Most Windows users, of course, see dialog boxes like this all the time. For 
example, legitimate audio and video files commonly require the download of a 
particular compressor-decompressor, or codec. That perfectly ordinary situation 
displays a very similar codec-update dialog. (I discuss, below, a safe way to 
update codecs.) 
In the case shown above, the message does say Security Warning, but so do 
many other alert boxes. It's very natural for Windows users to click OK on boxes 
such as this one, and huge numbers of people have done so. After all, the dialog 
box says the download is required! (For details, see Edelman's original report.) 
Microsoft's response to the outcry over this unacceptable behavior was pathetic. 
For at least a week, the company initially said the misleading dialog boxes were 
using a "by-design feature" of WMP, which wouldn't be changed. The company 

(Continued on page 14) 
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(Continued from page 13) 
then reversed course, telling eWeek in January that a patch would be available 
by mid-February. 
Patches that allowed WMP 10 users to switch off the deceptive behavior were in 
fact released by then. But no patches were made available for WMP 9, which is 
used by more people, according to an April 14 eWeek article. 
Microsoft finally released security advisory 892313 and the related Knowledge 
Base article 892313 on May 10. These articles described the problem and linked 
to an update for WMP 9 that had been posted a few days earlier. 
Unfortunately, the WMP 9 patch is available only for users of Windows 2000 and 
2003, not users of Windows 98 or Me. Worse, neither the advisory nor the KB 
article tells WMP 9 and 10 users that they must change a setting to turn the 
protection on after installing the upgrades. Finally, as far as I can determine, 
neither Windows Update nor the newer Microsoft Update bothers to inform users 
of the need for these upgrades. 
What to do: Users of Windows XP with Service Pack 2 (SP2) who also have 
Windows Media Player 10 installed are not vulnerable to the problem. For 
everyone else, I've put together the following steps to make you immune. 
WMP is "integrated" into Windows and you can't easily remove it. For this reason, 
I urge you to upgrade WMP's components to the latest version available for your 
OS, even if you never use it. Then apply patches as described in the steps below. 
WMP 10 will run only on Windows XP. WMP 9 will run on Windows 98 SE, Me, 
2000, and 2003 as well as XP. 
Users of Windows XP: First, if you don't have SP2 installed, I recommend that 
you install it now, using the XP SP2 page or the new Microsoft Update (requires 
Internet Explorer). While you're at it, use Microsoft Update to get the latest 
security patches for XP. Then, if you don't have WMP 10, get it from Microsoft's 
download center. Once WMP 10 is installed, read security advisory 892313 and 
install the update for WMP 10 using the link in KB article 892313. Finally, read 
section 9.4 of Microsoft's WMP FAQ. Follow the instructions in bullet point 4 to 
turn off auto-acquisition. To do this in WMP, right-click the title bar, then click 
Tools, Options, Privacy, then turn off Acquire licenses automatically for 
protected content. 
Users of Windows 2000 or 2003: First, use the new Microsoft Update (requires 
IE) to get the latest security patches for your OS. Then, upgrade to the latest 
version of WMP 9 using Microsoft's download center. Once the updated WMP 9 
is installed, read security advisory 892313 and install the update for WMP 9 using 
the link in KB article 892313. Finally, read section 9.4 of Microsoft's WMP FAQ. 
Follow the instructions in bullet point 4 to turn off auto-acquisition. To do this in 
WMP, right-click the title bar, then click Tools, Options, Privacy, then turn off 

Acquire licenses automatically for protected content. 
Users of Windows 98 SE and Me: WMP 9 will run on these OS versions, but 98 
SE and Me are so old that Microsoft no longer supports them and I don't 
recommend them. There's no patch for WMP 9 on these operating systems. If 
you have a PC that's running 98 SE or Me, check whether it meets the hardware 
requirements for XP using Microsoft's upgrade center. If so, I urge you to 
upgrade to XP SP2 and WMP 10, even if you have to pay money for a retail copy 
of XP. 
 All users: Upgrading to the latest Windows security patches, which I 
recommend above as step one, eliminates other security holes that affect WMP. 
For example, being current with all patches stops WMP 9 from being infected by 
poisoned PNG images, as described in MS05-009. Also, Windows Update may 
already have installed patch 828026, which dates back to September 2003. 
Administrators should use the three Registry values described in the related KB 
article 828026 to stop WMP 9 from responding to URL script commands. 
Note that even taking the steps above may allow some media files to display 
dialog boxes, which you must take care to answer correctly. As far as I'm 
concerned, no video is important enought to answer Yes to any dialog box a 
strange file opens, if WMP is the media player. (If you need an updated codec, 
download it separately from a legitimate source, such as the ones recommended 
by Microsoft in "How do I find a codec?") 
If you're running XP SP1 or higher or 2000 SP3 or higher, you can restrict access 
to WMP, although you can't easily remove it. You do this using Windows' Set 
Program and Access Defaults feature. Follow the instructions in section 2.4 of 
the WMP FAQ. 
By the way, don't bother using KB 190990, entitled "How to determine the version 
of Windows Media Player," to determine your version of WMP. Despite being 
revised as recently as Mar. 24, 2005, the article shows the wrong current version 
numbers for WMP 9 and 10. 
After you've upgraded and patched WMP, you may also wish to install one of the 
third-party media players mentioned later in this article. Let the new player 
associate multimedia file extensions with itself so WMP never runs. That's the 
best you can do to keep audio and video files from automatically launching WMP. 
When security holes are discovered in the future, my guess is that other vendors 
will fix their problems quicker than Microsoft will. 
iTunes isn't safe just because it's Apple 
Apple software doesn't suffer from security flaws as often as Microsoft's does, but 
problems aren't unheard of. You need to stay abreast of Apple updates, 

(Continued on page 15) 
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In addition, RealNetworks' software raises security issues for both companies 
and individuals. RealPlayer and RealOne Player are configured by default with 
Internet-access features that allow RealNetworks and its partners, such as 
NASCAR and CNN, to install additional software, according to WatchGuard 
Technologies. 
Most recently, RealNetworks released patches for its software — including 
RealPlayer, realOne Player, RealPlayer Enterprise, and Rhapsody — on June 
23, 2005. These programs, if unpatched, can let hackers access a PC if the user 
plays a hacked MP3 audio file or AVI video file, or even visits a Web site that 
plays multimedia content. 
What to do: Read the descriptions of the latest security hole provided by eEye 
Digital Security and RealNetworks. Then review any patches that may apply to 
you on RealNetworks' security page. 
Finally, upgrade any RealNetworks software you may have to the latest version 
that's safe. For example, RealNetworks' June 23 bulletin says these versions are 
not at risk: RealPlayer 10.5 (build 6.0.12.1212) and Rhapsody 3 (build 0.1141). 
Winamp falls victim to sneaky MP3s 
 Winamp is such a widely used media player that it's listed as the 32nd most 
popular file at CNET's Download.com. Unfortunately, like the other player apps, 
Winamp, too, has had its share of programming blunders that exposed users to 
danger. 
In the latest case, merely playing an MP3 file in Winamp can cause hacker code 
to silently run. This can potentially plant a Trojan horse on a computer, according 
to a July 14 analysis by a security research group in Croatia named LSS 
(Laboratorij za Sustave i Signale). 
Winamp released a new version on July 19 that fixes the flaw. 
What to do: Read the analysis by LSS, then upgrade to Winamp 5.094 using 
Winamp's download page. 
C'mon, get it together, developers 
 Of all of the Windows applications we use, media players that simply play audio 
or video clips should be risk-free. It isn't asking too much for developers of these 
programs to subject them to thorough security audits and neutralize any possible 
threats. 
Enjoying podcasts should be a simple matter that doesn't expose users to 
serious risks. We're not there yet, so — until that day comes — you need to give 
your media player periodic patches in order to use podcasts safely. 
You might think that a podcaster would never risk losing audience share by 
including a virus in a regularly scheduled show. But a podcaster's PC might 

(Continued on page 16) 
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especially for its popular iTunes media program, just as you do with Windows 
apps. 
A flaw in iTunes was announced by Apple as recently as May 9, 2005. The 
problem allows a hacked MPEG4 file (.mp4) to silently install a Trojan horse on a 
computer. This wouldn't affect an iPod or other specialized MP3 player. Nor 
would it likely affect Apple's OS X operating system, which protects users from 
installing software unknowingly. But it would be a big problem in Windows, which 
by default runs with administrator privileges all the time, allowing viruses to 
quietly install themselves. 
Fortunately, Apple released an upgrade, iTunes version 4.8, on May 9 to correct 
the problem on Windows 2000 and XP and OS X 10.2.8 or higher. Even better, 
Apple released iTunes version 4.9 on June 28, which is the first version that 
supports podcasting. You should upgrade iTunes to 4.9 immediately. 
What to do: First, read the description of the MPEG4 problem provided by SANS 
and Apple. Then, upgrade to iTunes 4.9 using Apple's download page. 
QuickTime can play more than videos 
 QuickTime is another Apple program, this one primarily used to display short 
videos. The application runs on both Windows and Mac and often comes 
preinstalled on PCs. It's also widely downloaded by people who want to view 
movie trailers provided by Hollywood studios and other content. 
QuickTime was found in September 2004 to be hackable if it was used to display, 
of all things, a still-image bitmap file (.bmp). If you happened to load a poisoned 
bitmap, it could silently take over your PC while the image was being displayed 
as though nothing was wrong. 
Apple released QuickTime 6.5.2 on Oct. 27, 2004, to correct the problem. Since 
that date, it's released QuickTime 7.0. But that version was found to allow media 
files to send data from your computer back to a hacker's Web server. The 
company released QuickTime 7.0.1 on May 31, 2005, to patch this. 
What to do: Read Apple's descriptions of the problems corrected by QuickTime 
6.5.2 and 7.0.1. Then upgrade to QuickTime 7.0.1 using Apple's download page. 
Music and movies can hack RealPlayer 
 RealPlayer is one of the most popular media players on the market, with 
hundreds of millions of downloads of its free player and more than 2 million 
paying subscribers, according to a company statement. 
But RealPlayer and other products made by RealNetworks have had a troubled 
history with security holes and privacy issues. The company lists on its security 
page more than a dozen patches that have been required for its media products, 
including RealPlayer and RealOne Player, in the past 2-1/2 years. 
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(Continued from page 15) 
inadvertently get infected, adding a hidden virus to a file without anyone noticing 
until it had gone out to thousands of people. 
In addition, viruses these days don't seek to erase a PC's hard drive. Instead, 
they aim to quietly take over the PC's bandwidth, and big dollars are at stake. 
Podcasters have already received financial offers to distribute adware within 
podcatching software, according to a public warning by Nick Bradbury, the 
developer of FeedDemon. We all have to keep our guard up against this threat 
ZoneAlarm 6.0 apps encounter install problems 
By Brian Livingston 
The latest version of ZoneAlarm products is beset with reports of incompatibilities 
and other problems. 
I reported on July 28 that version 6.0 of the ZoneAlarm Security Suite was 
released. This version, for the first time, integrated antispyware functions with the 
product's existing firewall, antivirus, and antispam features. I also reported that 
the suite had already received a PC Magazine Editors' Choice award. Zone Labs, 
the product line's publisher, subsequently released its new standalone firewall 
product, ZoneAlarm 6.0, on Aug. 5. 
Zone Labs' user forum has been humming with complaints from users that 
version 6 of the company's software has disabled other applications, interferes 
with POP3 e-mail downloads, and has other issues. 
At the top of its user forum page, Zone Labs acknowledges that there are 
problems. "The cause appears to be related to the upgrade process, not the 
application itself," the company says. "Therefore, we recommend users 
experiencing difficulties uninstall any prior version of ZoneAlarm (v.2.x - v.5.x) 
residing on their computer system and do a clean installation of their new 
ZoneAlarm 6.0 product." 
Uninstalling ZoneAlarm 6 can be tricky, so if you're having the above problems, 
please read Zone Labs' uninstall instructions page. 
I'm grateful to the many readers who've passed their comments about ZoneAlarm 
6 problems along to me. Particularly provocative were these remarks (edited for 
length) by Lorin Ricker: 
n "Please be aware that a major installation disaster has been unleashed 

on the ZoneAlarm Pro user community by Zone Labs' recent (Friday 8/5) 
release of ZAPro v6.0. For details, please see Zone Labs' User Forums 
under the topic 'Installation, Uninstallation and Upgrade.' 

n "This is a classic and major instance of a company shooting itself in the 
foot, as they've caused major time-and-effort loss, technical and practical 
headaches, and compromises of security for countless loyal product 

users. 
n "Although I certainly understand the degree of complexity in designing 

and implementing a kernel-mode security product like a personal firewall, 
for the life of me I cannot understand why upgrade installation processes 
should be so damn complicated and full of technical and operational 
pitfalls for the ordinary PC user. This is another example of technical 
engineering and product management doing a simply slipshod job of 
product delivery. Makes one suspect that Zone Labs has been infiltrated 
by Microsoft technical management! ... 

n "Given ZoneAlarm's tenure on the Windows Secrets Newsletter's 
Security Baseline and its prior position as a 2004 PC Magazine World's 
Best rated product, it's probably time to ask Brian and Paul the following 
question: 

n "In light of this recent ZA v6 release/installation disaster, what is the best 
personal/PC firewall (only, not a "suite") which could replace a 
ZoneAlarm Pro installation? 

n "Background: I believe that there are a great number of PC users who, 
for any number of reasons, do not think that the world revolves around 
Micro$oft, and who therefore do not use 'mainline' MS products like 
Outlook/Express, Internet Explorer, etc. This position naturally leads us 
to a 'security baseline' of products which do play well with alternative 
applications such as Firefox (anti-spyware such as CounterSpy), 
Thunderbird (antispam such as G-Lock SpamCombat), Panda Titanium 
antivirus, etc. 

n "Thus, in spite of the convenience to the non-technical users out there 
who probably appreciate an all-in-one security suite product (whether it's 
individual components actually work well or not), many of us feel forced 
to use — or best off if we can use — individual, best-of-breed products to 
form our own security baseline. 

n "I hope this whole issue gets sufficient coverage in the next issue of the 
newsletter! Thanks!" 

Which software is the best standalone personal firewall? I don't have a testing lab 
and I don't ordinarily test products. Instead, I scrutinize the ratings that are issued 
by respected reviewers who do have testing labs. These ratings are then 
summarized by me in the newsletter. 
Prior to the release of Zone Labs' 6.0 version of its products, testers had 
overwhelmingly rated ZoneAlarm 5.5 as the best standalone software firewall. 
Since that version is still available and supported, people who are uncomfortable 

(Continued on page 17) 
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with the new "point-oh" release should stick with 5.5 (or revert back to 5.5). You 
can download free or trial versions of version 5.5.094 at the following locations: 
ZoneAlarm Free, ZoneAlarm Pro, ZoneAlarm Security Suite, ZoneAlarm 
Antivirus. 
However, I think it's too soon to give up on ZoneAlarm Security Suite 6.0. Zone 
Labs will surely find and correct the incompatibilities soon. Not everyone who 
installs a 6.0 version of Zone Labs products is having problems. Those who do 
have problems seem to have installed 6.0 over a previous install. That should 
work fine, but in this case it apparently does not. 
While many computer users are savvy enough to put together their own security 
suite from unrelated products, many other users are not. Most PC novices would 
benefit from having a single package that met all their needs for antivirus, 
antispam, antispyware, and firewall protection. 
I invite my readers (who have test machines) to uninstall previous ZoneAlarm 
products and clean-install the new 6.0. As readers report their results — and as 
professional testing labs turn out new ratings — Zone Labs may continue to rise 
to the top of all security suites, or there may be a new winner. I'll let you know in 
future issues.  
From Windows Secrets 12/8/2005 

PROFOUND THOUGHTS....number two 
1. If you're too open-minded, your brains will fall out. 
2. Don't worry about what other people think; they don't do it very 

often. 
3. Going to a church doesn't make you a Christian, any more than 

standing in a garage makes you a car. 
4. It isn't the jeans that make your butt look fat. 
5. Artificial intelligence is no match for natural stupidity. 
6. My idea of housework is to sweep the room with a glance. 
7. Not one shred of evidence supports the notion that life is serious. 
8. It is easier to ask for forgiveness than permission. 
9. For every action, there is an equal and opposite government 

program. 
10. If you look like your passport picture, you probably need the trip. 
11. Bills travel through the mail at twice the speed of cheques. 
12. A conscience is what hurts when all your other parts feel good. 
13. Eat well, stay fit, die anyway. (Just remember how lucky you were 

to get a free trip around the sun.) 
14. Men are from earth. Women are from earth. Deal with it. 
15. No man has ever been shot while doing the dishes. 
16. A balanced diet is a cookie in each hand. 
17. Middle age is when broadness of the mind and narrowness of the 

waist change places. 
18. Opportunities always look bigger going than coming. 
19. Junk is something you've kept for years and throw away three 

weeks before you need it. 
20. There is always one more imbecile than you counted on. 
21. Experience is a wonderful thing. It enables you to recognize a 

mistake when you make it again. 
22. By the time you can make ends meet, they move the ends. 
23. Thou shall not weigh more than thy refrigerator. 
24. Someone who thinks logically provides a nice contrast to the real 

world. 
25. If you must choose between two evils, chose the one that you've 

never tried before 
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COMPUTER TIPS AND HINTS 
Windows XP  
Exclude a Program from the Start Menu 
You can remove a program shortcut from the left side of the new Start 
menu (where XP shows you a number of most frequently used programs) 
by right clicking the shortcut and choosing Remove from This List, but you 
will notice that after some time (if you continue to use the program), it will 
reappear. 
There is a way to ban programs from this part of the Start menu perma-
nently: 
1. Start the Registry Editor 
2. Go to HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \ Windows \ 
CurrentVersion \ Explorer \ FileAssociation \ 
3. Right-click the String Value AddRemoveApps, and select Modify 
4. Add the name of the programs executable at the end of the Value data, 
make sure that the name is preceded by a semicolon (;) 
5. When ready, press OK and close the registry editor 
6. Log off, or restart Windows for the changes to take effect  
Windows 98 
Stop Automatic Dialing 
To stop your browser - or any other Internet aware application - from auto-
matically dialing up your ISP: 
1. Click Start and select Programs > Settings > Control Panel 
2. Open Internet Options 
3. Select the Connections tab 
4. Check Never dial a connection 
5. Also click Start and select Programs > Accessoires > Communications 
> Dial-Up Networking 
6. From the Connections menu, choose Settings... and check prompt to 
use Dial-Up Networking  
Microsoft Word 
How do I get Word to stop helping me type? 
There are several places to look to turn off Word's various automatic fea-
tures: 
1. Choose AutoCorrect (or AutoCorrect Options) from the Tools menu, 
then click on the AutoCorrect tab. 

2. Clear the check boxes for the AutoCorrect items that you want to dis-
able. 
3. Do the same for the AutoFormat As You Type tab. 
4. On the AutoText tab, clear the Show AutoComplete tip check box. 
5. Choose Options from the Tools menu, then click on the tabs and clear 
any check boxes for features that you want to disable. For example: 
* Edit tab (Tabs and backspace set left indent). 
* Spelling & Grammar tab (Check spelling as you type and Check gram-
mar as you type). When these features are on, spelling and grammar that 
Word does not recognize are underlined with wavy red and green lines. 
How do I tell the Office Assistant to go away? 
1. Click on the Office Assistant, then click on Options. 
2. Clear the Use Office Assistant check box. 
You can also customize the behavior of the Office Assistant by checking 
or clearing the checkboxes on the Options tab. If you want to learn how to 
customize the Office Assistant, but it's not currently visible, choose Show 
the Office Assistant from the Help menu. 
Internet 
Improving browsing performance for Internet Explorer. 
You can improve Internet Explorer's browsing performance by disabling 
graphics, sound, music, video, and other multimedia files. This will allow 
you to browse faster and more efficiently if you are just interested in get-
ting text. To do this: 
* Click Options from the View menu. 
* Click the General tab (it should be the default tab). 
* Now you can deselect the options you don’t want to have from the Multi-
media section. This way you can speed up your browser performance. 
Tip of the Day 
Want to see a new IE 5.0 tip every time you run your browser? Just click 
on the "Help" menu and choose "Tip of the Day." A new bottom pane will 
appear with a new tip every time you start IE 5.0.  
Digital Photography 
What quality setting should I use on my camera? 
The basic rule is to select the right size of images based on your applica-
tion. Small images require much less hard disk space and processing 
time than large ones. Be aware of how much disk space you have on your 
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system when you take your pictures. If your available disk space is lim-
ited, you may only be able to copy a few photographs from your camera 
to the computer. 
If you plan to use your pictures on the Web, smaller pictures may be bet-
ter. Typical digital camera pictures are over 1000 pixels wide and 500K in 
size. Pictures used on the Web are usually much smaller (for example, 
500 pixels wide and less than 100K). You can either set the camera to 
take smaller pictures or use Ulead Photo Explorer to perform the conver-
sions. 
Some cameras allow you to adjust the photo compression before you take 
the pictures. By increasing the compression, you will get smaller file sizes. 
This allows you to collect more images in your camera (like getting a 
longer roll of film) and copy more to your computer. If you only have a 
small memory card, you can take more pictures by using a lower resolu-
tion setting. However, images with higher compression will not be so 
sharp or as accurate as images with lower compression. 
Some cameras offer very high quality modes for special applications. Use 
these with care, since the files are large and the image quality is often not 
much better. 
For general photography, try to use the best image settings for cameras 
up to about 2M pixels. For cameras with larger sensors, the files may take 
excessive time to transfer to your computer, display or other systems. 
There may be a lot more data than you need. Consider if you would be 
better to use a lower compression setting.  
What's Your Angle? 
After a lengthy search you've scoped out an ideal spot for a cityscape 
photo; or, maybe you picked a great holiday destination months ago with 
opportunities for some once-in-a-lifetime architecture shots. Now, you 
want to capture the grandeur "on film" (or more likely, on CCD, but some-
how that doesn't have the same ring to it). Of course, a mountain of fac-
tors play into getting the photos you really want, but by keeping these tips 
on shooting angle in mind you can add more interest to your pictures and 
improve your chances of getting dramatic results. 
Depth Finder (Architecture): It's always good to keep in mind that just be-
cause a scene looks good to your eye, doesn't mean you'll get a good 
photo by simply lifting the camera and snapping away. Remember, our 

eyes see a lot more than you can get into a photo, so to convey depth and 
context in your close range photos of buildings and grounds it's best to 
choose an oblique angle from your subject. Not only will this give you a 
picture of more than one side of the building and thus provide more detail, 
it will also add depth by giving a better perspective of the building's sur-
roundings and background. 
Moreover, shooting from an angle will introduce noticeable diagonal lines 
that lead from bottom to top and side-to-side and draw the eye through 
the photo. Far from taking away from the impact of your subject, drawing 
the eye through the photo so it notices more surrounding detail will en-
hance the impact of your subject by keeping it from appearing as a stark 
and overpowering chunk of stone and metal just floating there. It's worth 
noting that this technique works when shooting inside buildings as well. 
"You Are Here" (Cityscapes): Whether traveling in an exotic city or just ex-
ploring your own urban playground, if you're carrying your camera there'll 
be plenty of occasions when you think, "Hey, just a sec, let me get a shot 
of this." One way to get really memorable shots is to look for genuine city-
scapes rather than street photos. This means finding a high point, 
whether a window, balcony, rooftop, or the like. 
As you look for a promising location and then line up your shot, make sure 
you include a view of your immediate surroundings as well, rather than 
just the pretty buildings in the distance. And this means what's as close to 
right below you as you can manage and still get those distant buildings in. 
Doing this will lend your photos a sense of, well, "immediacy" or being in 
the scene - the "you are here" factor, if you like. 
Macintosh  
Use Your Hand 
You can use a hand to move around an icon view window. Command/
Option/clicking on an open space in the window lets you do this. 
Preventing Mac Disasters 
Macworld’s February issue has a great article on preventing Macintosh 
disasters. You can read the entire piece at http://www.macworld.
com/2005/01/features/preventmacdisasters/index.php. 
Briefly, here is what Macworld has to say. They list eight steps you can 
take to keep your Mac working well. 
1. Verify Preferences 
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Preferences can get corrupted. To verify your Preferences, the simplest 
way is to get Jonathon Nathan’s free Preferential Treatment application at 
http://homepage.mac.com/jonn8/as/. If you find a file which not only 
shows up as corrupted, but is not a preference for an application which is 
working fine, quit the offending application, trash the corrupted Preference 
file, then restart the application. Applications rebuild the preference file if 
one is not found. You may have to redo by hand some custom prefer-
ences. 
2. Repair Permissions 
The more you download shareware or install new applications, the more 
often you need to repair Permissions. Open the Utilities folder in the Appli-
cations folder, locate Disk Utility and open it. Use the First Aid pane. Se-
lect the indented icon of the drive on which you wish to repair Permissions 
(Macintosh HD in this case) and click on “Repair Disk Permissions.” Al-
ways Repair Permissions immediately after installing any new software. 
Plan on running Repair Permissions weekly if you tend to download a lot 
of software. 
3. Delete Cache Files 
Cache files are temporary places where your Mac keeps information for a 
limited amount of time. Sluggishness in an application or in the System 
can mean that you have cache files that need to be removed. Titanium 
Software’s free OnyX 1.4.9 will remove caches. Find it at www.titanium.
free.fr/english.html. This tool does not get rid of application-specific 
caches. If you like French Fries, try this. If you only like Freedom Fries, 
you will have to look elsewhere. Titanium is a French company. Macworld 
suggests getting rid of cache files twice a month. Cache files are located 
in System > Library > Caches and in Users > Username > Library > 
Caches folder. 
4. Delete Log Files 
Log files simply record system and application-related activity. They just 
keep growing over time. They don’t get very big, so if you choose not to 
get rid of them, there is no space penalty. Titanium’s free OnyX, men-
tioned above, gets rid of Log files. MacWorld also tells you how to use 
Console, located in the Utilities folder, to delete Log files. 
5. Update Prebinding 
Prebinding makes applications load faster. Updating prebinding can make 

applications launch faster. Once again, Titanium’s free OnyX updates pre-
binding when you choose optimization in the Maintenance scripts in Tita-
nium. Prebinding is simply a way your Mac records the code an applica-
tion needs to use to launch. Users of Panther do not need to update Pre-
binding, but there is no harm in running it. 
6. Automate Maintenance 
OS X runs some scripts automatically. The scripts delete unnecessary 
data your Mac creates as it runs. If your Mac is awake when the scripts 
are scheduled to be run, you have no worries. The scripts run between 
3:15 and 5:30 am. So if you turn your Mac off at night, you need to run 
these scripts yourself. Titanium’s free OnyX runs them under the Mainte-
nance Tab. 
7. Take Good Care of Your Hard Drive 
There is a SMART (Self-Monitoring Analysis and Reporting Technology) 
system that checks on your hard drive and warns of failures before they 
occur. You can run SMART using DiskWarrior. Disk Warrior is the tool 
that most Mac experts say is the finest tool you should own. You should 
own DiskWarrior, but before you use it, be sure to reboot using your In-
stall CD. Do NOT proceed with an Install, but go to the Installer menu and 
select Disk Utility. In Disk Utility, run Repair Disk. 
8. Prepare a Maintenance Toolbox 
Why wait until you have a problem to download the tools you will need. It 
will be obvious to you that you need OnyX and DiskWarrior. MacWorld 
also adds SmartReporter, which is free at http://homepage.mac.com/
julianmayer/. You might add Jonathon Nathan’s free Preferential Treat-
ment application. DiskWarrior does check SMART status, so you might 
not feel a need for SmartReporter. 
So there you are. Eight ways to keep your Mac in top shape. Be sure to 
go to the web site listed in the first paragraph and read the entire article. 
There is far more to keeping your Mac in good shape than this short re-
view describes. -- Phil Russell 
From SeniorLink Sentinel August 2005 


